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SMART GPU 2– Intelligent Embedded Graphics,  Audio and Touch Processor. 
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Smart GPU 2:  

Intelligent Embedded Graphics, Audio and Touchscreen Processor. 

Description:   
 

      The Smart GPU 2 is a powerful easy to use, 
intellectual property, embedded graphics, audio 
and touchscreen processor in a state-of-the-art 
ARM Cortex-M3 chip; this is mounted on a board 
with a touchscreen color LCD. It's aimed to help 
developers to create advanced Graphical User 
Interfaces (GUIs) in a very easy way. It features 
high end FAT format data management 
functions (Data Logger) to create even more 
advanced applications in just minutes, not days. 
The Smart GPU 2 processor doesn’t need any 
configuration or programming on itself, it’s a 
slave device that only receives orders, reducing 
and facilitating dramatically the code size, 
complexity and processing load in the master 
host processor. 
 

 
The Smart GPU 2 offers a simple yet effective serial interface UART to any 

host micro-controller/microprocessor that can communicate via a serial port(8051, 
PIC, ATMEL, FREESCALE, STMICRO, ARM, CORTEX, ARDUINO, raspberry PI, 
FPGA MBED, etc. even PCs(RS232)). All graphics, audio and touchscreen related 
functions are sent using simple commands via the serial interface. 

 
 
The main goal of the Smart GPU 2 processor it’s to bring a very easy way to 

add colour, audio and touch interfacing to any application or project without the need 
of having experience in handling LCDs and graphics algorithms. The Smart GPU 2 
it's a low power/very high performance processor, it integrates the 
FAT/FAT12/FAT16 or FAT32 universal PCs file System for data storage (read/write), 
supporting up to 32 GB of storage with a microSD/HC card, NO special format is 
required.  

 

SmartGPU2 chip is also sold as “bare chip” for high end applications 
and can be adapted to drive any LCD with parallel 8080 interface. 
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The next image clearly explains the roles played by the user host main 
processor and the Smart GPU 2 processor: 

 

 
 

Instead of loading all the Geometry, Images, audio, video, SD FAT memory 
access, etc. processing to the main host processor, the Smart GPU 2 does the 
entire job and stuff in parallel with the user microcontroller/microprocessor by 
receiving simple orders or commands. 
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Board Features:   
 

 2.4“, 320x240 pixels resistive touchscreen LCD, capable of 
displaying 262,144 colours. 
 

 Easy 5 pin interface to any host device: VCC, TX, RX, GND, 
RESET. 
 

 On-board uSD/uSDHC card adaptor, FAT(windows PC) 
Support up to 32GB for storing images and text, Data 
Logger functions (read-write) and LFN(long File Names). 

 

 BMP and JPG images support. 
 

 Video and Audio(CD quality) capable. 
 

 Integrated 2 channel DACs outputs can play stereo audio. 
 

 Integrated Touch screen driver, 12 bit accuracy touch. 
 

 5 general purpose Icons on touchscreen panel. 
 

 Integrated RTC - Real Time Clock with battery back-up. 
 

 PWM controlled display brightness. 
 

 Sleep mode. 
 

 UART/USART Baud Rate speeds from 9600bps up to 
2000000bps, 8 bits, no parity, 1 stop bit. 

 

 5V and 3V3 I/O compatible, 3V3 power supply. 
 



SMART GPU 2 2.4” TOUCH Datasheet         

 

 
Vizic Technologies ©2013                                                                                                               7 

 

 

Smart GPU 2 Board – EXPLAINED 
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1.-Host Interface   
                                                                           

The Smart GPU 2 is a slave peripheral device and it provides a bidirectional 
serial interface to a host controller via its USART(Universal Serial Asynchronous 
Receiver - Transmitter).  

 
Any microcontroller or processor (AVR, PIC, BASICstamp, XXDUINO, raspberry 

PI, 8051, MBED, FPGA, ARM, STmicro, etc) or PC(by serial interface RS232) as host, 
can communicate to the device over this serial interface from 9600bps up to 
4000000bps. 

 
The Smart GPU 2 doesn't need to be configured in any way; it's a plug-and-play 

device, could be used by students, up to industrial and professional applications, its 
compatible with any device and existing development board with a USART/UART. 

 
 
The serial protocol is universal and very easy to implement. 
Serial Data Format: 8 Bits, No Parity, 1 Stop Bit.  
BaudRate: 9600 bps (default; could be changed).  
Serial data is true and not inverted. 
 
 
 
 

1.1 Command Protocol : Flow Control 
 

The Smart GPU 2 Intelligent Graphics Processor Unit is a slave device and all 
communication and events must be initiated first by the host. Commands consist of a 
sequence of data bytes beginning with the command/function byte.  
 

When a command is sent from host to the device, this process the command and 
when the operation is completed, it will always return a response*. The device will send 
back a single acknowledge byte called the ACK (4Fhex, ‘O’ ascii), in the case of 
success, or NAK (46hex, ‘F’ ascii), in the case of failure or not recognized command. 
 
* Commands having specific responses may send back varying numbers of bytes, depending upon the command and 
response. It will take the device a certain amount of time to respond, depending on the command type and the 
operation that has to be performed.  
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1.2 Serial Set-up  
 

The Smart GPU 2 is configured to be always initialized at a standard baud rate 
of 9600 bps. So the first command that the host sends to the Smart GPU 2 must be at 
that speed. 

  
Always after any power-up or reset, the Smart GPU 2 must be initialized by 

sending the uppercase ascii character ‘U’ (55hex) at 9600bps. This will initialize all the 
processor, and when done it will respond with an ACK byte (4Fhex, ‘O’ascii). 

 
If the Smart GPU 2 respond with a NAK(46hex, ‘F’ascii), Host must try to send 

the uppercase ascii character ‘U’ (55hex) again until a valid ACK is received, meaning 
this that Smart GPU 2 is ready and running. 

 
Once the chip is initialized, user can change the baud rate speed to a total of 8 

different speeds up to 2Mbps. 
 

Remember: 
The SMART GPU 2 always initializes the micro SD card after a valid ‘U’ character is received.  If a micro SD card is 
detected the ACK ‘O’ will be response almost immediately, however if no micro SD card is detected, the ACK ‘O’ 
could be delayed while the SMART GPU 2 retries to initialize a micro SD card, however if no micro SD card is 
detected after several tries, the SMART GPU 2 will send the ACK ‘O’ and the processor will function normally without 
the SD card functions. 

 
  

 
 

 

1.3 Power-up and Reset   
 

When the Smart GPU 2 device comes out of a power up or external reset, a  
200ms delay before sending any command must be met, do not attempt to 
communicate with the module before this period. 
 
 If no valid uppercase ascii character ‘U’ (55hex) is sent before 3 seconds, the 
Smart GPU 2 logo will automatically show up, host still can send the uppercase ascii 
character ‘U’ (55hex) to initialize the processor even if the logo has already appeared.  
 
Remember: 
The host transmits the upper case character (‘U’, 55hex) as the first command so the device to start communication. 
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1.4 Splash Screen on Power Up 
 

The Smart GPU 2 will wait up to 3 seconds with its screen in black, for the host to 
transmit the Initial command (‘U’, 55hex). If the host has not transmitted this initial 
command the module will display its splash screen. If the host has transmitted only the 
initial command and has received a valid ACK, the screen will remain in black. This wait 
period of the splash screen to appear, is to allow the user initialize the Smart GPU 2 
before the welcome screen appears when it is undesired. 
 
 
 

1.5 Understanding the Computer's graphic coordinate 
system 
 

As well as a computer monitor’s coordinate system, the Smart GPU 2 uses the 
same universal coordinate system, on computer’s there’s only one positive coordinate 
quadrant, and there’s no negative numbers or points. This quadrant is represented as 
follows: 

 
The upper left corner is 0,0 if we go right the X values increases, as we go down 

the Y values increase. 
 

 
 
This image shows a LANDSCAPE orientation of 
the screen, the upper left corner is 0,0 
(zero,zero). The maximum values of the SMART 
GPU 2 in LANDSCAPE mode are X:319,Y:239. 
 
 
 
 

 
 
 
 This image shows a PORTRAIT orientation of     
the screen, the upper left corner is 0,0    
(zero,zero). The maximum values of the SMART 
GPU 2 in PORTRAIT mode are X:239,Y:319. 
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1.6 Board Pin configuration 
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Pin Symbol I/O Description 

1 AL(DAC) Out Audio Left Channel Output analog 
pin, always use a >=100uF 
capacitor to decouple output. 
 

2 AR(DAC) Out Audio Right Channel Output analog 
pin, always use a >=100uF 
capacitor to decouple output. 
 

3 Transmitter Out  
5V / 3.3V 

Out Asynchronous serial transmit output 
pin, for 5V and 3.3V logic. 
 

4 Receiver In  
5V / 3.3V 

In Asynchronous serial receiver input 
pin for 5V and 3.3V logic. 
 

5 VCC 3.3V In Main voltage supply, 2.8v-3.3v. 
 

6 Ground In Supply Ground. 
 

7 Reset In Master reset signal, Internally 
pulled up to 3.3V via a 40K resistor. 
An active low pulse greater than 
100ns will reset the module. 5V 
tolerant input. 
 

8 Receiver In  
5V / 3.3V 

In Asynchronous serial receiver input 
pin for 5V and 3.3V logic. 
 

9 Transmitter Out  
5V / 3.3V 

Out Asynchronous serial transmit output 
pin, for 5V and 3.3V logic. 
 

10 Reset In/Out Switch Master reset signal, Internally 
pulled up to 3.3V via a 40K resistor. 
An active low pulse greater than 
100ns will reset the module. This 
pin acts as input when is connected 
to an external logic or 
microcontroller, and as output when 
the on board reset switch is 
pressed. 5V tolerant. 
 

11 VCC 3.3V In Main voltage supply, 2.8v-3.3v. 
 

12 No Connect - Not connected pin. 
 

13 Ground In Supply Ground. 
 

14 Ground In Supply Ground. 
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1.7 TYPICAL HOST CONNECTION: for 3.3V Systems 
*The SmartGPU2 must always be powered with 3.3V (TX, RX, and Reset pins are 5V tolerant). 

 
 
1.8 TYPICAL HOST CONNECTION: for 5V Systems 
*The SmartGPU2 must always be powered with 3.3V (TX, RX, and Reset pins are 5V tolerant). 
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1.9 Typical Audio headphones/speakers connections: 
 

The Smart GPU 2 supports stereo audio output, the pins labeled AL(Audio Left 
Channel) and AR(Audio Right Channel) are the audio DACs outputs. The processor can 
manage any Audio file, so files with .wav extension will be easily opened and played. 

 
The following circuit connections are recommended to achieve a good CLEAN 

headphones or speaker’s connection, no LPF or HPF Filter is applied to outputs. 
 

 
 

 
The SMART GPU 2 can play any RIFF-WAVE format sound files known as 

Microsoft wave file in LPCM:  8/16 bits, Mono or Stereo sound, and up to 48KHz 
sampling rate (CD Quality). Any other format of sound files (mp3,acc,wma,etc) 
must be converted to the .wav format.  

 
A complete tutorial on how to load Audio Files to the SD card is explained 

on this PDF file at the SD card file management section. 
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1.10 Typical RTC Real Time Clock connections: 
 
The Smart GPU 2 processor has an embedded RTC Real Time Clock to support 

full Time-Date calendar functions, also Data Logger applications that require a precise 
timestamp.  
 
           The real-time clock is an independent timer that counts every second and keeps 
information about Date(day, month, year) and Time(hours, minutes, seconds). The next 
RTC Timer Functions enable full possibilities with the Smart GPU 2. User can create full 
real time Graphic User Interfaces and Data-logger applications with clock-calendar 
functions with the accuracy that only a RTC provides. 
 
          The RTC is internal and ready to run, however to lower production costs, the RTC 
Crystal hasn’t been mounted on the board, a 32.768 Khz Crystal can be soldered to the 
OSC32 external pads to enable full RTC support. To avoid the RTC lose time and date 
data each time main VCC power is removed or shut down from the chip, a Standard 3V 
coin backup battery or similar can be connected between the pads noted as VBat and 
GND pin on the board, this way the RTC will continuously running conserving Time and 
Date data even the Smart GPU 2 chip is power off. 
 

The following circuit connections are recommended to achieve a good RTC 
Crystal and Back-Up Battery connection. 
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2. SMART GPU 2 Command Set - Software Interface 
Specification 
2. Command Set 

As mentioned before the command interface between the Smart GPU 2 and the 
host processor is via the serial interface USART/UART.  
 

A list of very easy to learn commands provide complete access to all the 
available functions. Commands and responses can be a single byte or a byte package. 
All commands always return a response, either a single ACK, or data followed by an 
ACK. 
 

Remember all commands start with a uppercase letter (ascii). 
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2.1 Command summary 
 
For detailed information, be sure to check the SmartGPU 2 COMMAND SET Sheet. 
 
General Commands:  
• Initialize SMART GPU                – 55hex ‘U’  
 
Master Commands:  
• Erase Screen                             – 45hex ‘E’ 
• Set Erase Background Colour   – 43hex ‘C’ 
• Display Orientation                     – 4Fhex ‘O’ 
• Display Brightness                      – 42hex ‘B’ 
• BaudRate Change                      – 58hex ‘X’ 
• Sleep                                          – 5Ahex ‘Z’ 
• Calibrate Touch                           – 54hex ‘T’  
• Software Reset                            – 52hex ‘R’  
 
Geometry Commands:  
• Put Pixel                            – 50hex ‘P’  
• Draw Line                          – 4Chex ‘L’  
• Draw Rectangle                 – 52hex ‘R’  
• Draw Round Rectangle     – 4Fhex ‘O’ 
• Draw Gradient Rectangle  – 47hex ‘G’  
• Draw Arc                            – 41hex ‘A’ 
• Draw Circle                        – 43hex ‘C’ 
• Draw Ellipse                       – 45hex ‘E’ 
• Draw Triangle                     – 54hex ‘T’  
 
String/Text Commands:  
• Put Letter                      – 4Chex ‘L’ 
• Print Number                  – 4Ehex ‘N’     
• Display String                – 53hex ‘S’ 
• Display String SD          – 46hex ‘F’    
• Strings Configuration     – 43hex ‘C’ 
 
Image Commands:  
• Draw Image/Icon – 49hex ‘I’  
• Image BMP SD    – 42hex ‘B’  
• Image JPG SD     – 4Ahex ‘J’  
• Memory Read      – 4Dhex ‘M’  
• Screenshot BMP  – 53hex ‘S’ 
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Video Commands:  
• Allocate Video SD       – 41hex ‘A’  
• Play Video SD             – 50hex ‘P’  
• Set Frame Video SD   – 46hex ‘F’  
• De-allocate Video SD  – 44hex ‘D’  
 
Audio Commands:  
• Initialize/De-initialize DACs/Audio  – 49hex ‘I’ 
• Play WAV File                                – 50hex ‘P’  
• Pause WAV File                             – 57hex ‘W’  
• Advance WAV File                         – 41hex ‘A’ 
• Stop WAV File                                – 53hex ‘S’  
• Set Volume WAV                            – 56hex ‘V’  
• Get Playing State                            – 47hex ‘G’  
• Audio Boost                                    – 42hex ‘B’ 
 
Touch Commands:  
• Get Touchscreen  – 53hex ‘S’  
• Get Touch icons    – 49hex ‘I’  
 
FAT Data Management/ Data Logger:  
• List Dirs and Files                      –4Chex ‘L’  
• Get name Item#                         –47hex ‘G’  
• Get Dir Path                               –48hex ‘H’  
• New Dir/File                               –4Ehex ‘N’  
• Open Dir                                     –44hex ‘D’  
• Open File                                    –4Fhex ‘O’  
• Read File                                    –52hex ‘R’  
• Write File                                    –57hex ‘W’  
• Set/Get Pointer                           –50hex ‘P’  
• Sync File                                     –53hex ‘S’  
• Test Error-EOF                          –51hex ‘Q’ 
• Close File                                    –43hex ‘C’  
• Truncate File                               –56hex ‘V’  
• Erase Dir/File                             –45hex ‘E’ 
• Dir/File Rename/move               –4Dhex ‘M’ 
• Set/Get Time and Date Dir/File  –54hex ‘T’ 
• Get Dir/File Info                          –49hex ‘I’ 
• Get Free and Total Space          –46hex ‘F’ 
 
RTC Real Time Clock Commands:  
• RTC Setup                              – 53hex ‘S’  
• RTC Set/Get Time and Date  – 50hex ‘P’  
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EEPROM-FLASH Commands:  
• Read from EEPROM Buffer                  – 52hex ‘R’  
• Write to EEPROM Buffer                      – 57hex ‘W’  
• Fill Buffer with EEPROM Page#           – 46hex ‘F’  
• Save Buffer to EEPROM Page#           – 53hex ‘S’  
• Erase EEPROM Page#                         – 45hex ‘E’  
• Compare Buffer to EEPROM Page#    – 43hex ‘C’  
• Init/Clear EEPROM Buffer                     – 49hex ‘I’  
 
Objects Commands:  
• Object Button               – 42hex ‘B’ 
• Object Checkbox          – 43hex ‘C’ 
• Object Switch               – 54hex ‘T’ 
• Object Progress Bar     – 50hex ‘P’ 
• Object Scroll Bar          – 53hex ‘S’  
• Object Slider                 – 4Chex ‘L’  
• Object Window             – 57hex ‘W’ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



SMART GPU 2 2.4” TOUCH Datasheet         

 

 
Vizic Technologies ©2013                                                                                                               20 

 

 
3 Micro SD File/Folder organization 
 

The Smart GPU 2 is capable of managing nested folders, so a complete files and 
folder organization could be achieved inside the micro SD card. Also the Smart GPU 2 
could directly access nested folders for example: “0:/rock/punk/oldies/song.wav”.  
 
 The next image gives some examples of files/folders organization/nesting that 
can be achieved and accessed with the Smart GPU 2 processor: 
 
 

 
 
   For a detailed information about how to access nest folders please refer to the 
“SmartGPU2LCD320x240 - Command Set.pdf” file. 
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4 Micro SD card file management  
 

The Smart GPU 2 is capable of managing files directly in FAT/FAT12/FAT16 or 
FAT32 file systems without any special program/interface or micro SD rare formats.  
 

A maximum of 32GBs micro SD memory card is supported, allowing storing 
thousands of full screen images, videos, audio files/songs, and thousands of text files. 

 
The files are fully compatible format with any PC. This section explains how to 

load and create images (.bmp/.jpg), audio files (.wav) and text (.txt) files to be read with 
the Smart GPU 2 processor. 
 
 Note that FAT file system could be faster than FAT32 on some micro SD  

cards. 
 

4.1 Storing Images on the micro SD card 
 
 Any image could be prepared to be stored and loaded by the Smart GPU 2, the 
only requirement is the .bmp extension and desired size.  
 
 Any image processing software could convert or “Save As” images as .bmp or 
.jpg. To keep it simple, in this section the universal and easiest to use: Microsoft Paint 
software is used. 
 
 
1.- Open the Paint software. 
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2.- Go to File->Open, and select the desired image, or draw your own creation. 
 

 
 
3.-Press on the resize button on the main bar 
 

 
 

 3.1- A new window will pop-up: 
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3.2- We only care on the resize section of this new window, now select  
       PIXELS, and then write the size of the image, in this case we create 
       a full screen image (landscape) on the SMART GPU 2, that is 320X240  
       pixels. (Any size under 320x240 could also be chosen if we desire a non-full screen  

       image. In portrait mode we chose 240x320 for a full screen image). 

 

 
 
 
 
 

3.3- Press OK button and the image it’s now resized. 
 

 
 
 
 
 
 
 



SMART GPU 2 2.4” TOUCH Datasheet         

 

 
Vizic Technologies ©2013                                                                                                               24 

 

 
4.- Now go again to File->Save As->BMP or JPG picture, and click. 
 

 
 
 
5.- A new window pop-up, select any path of the micro SD, give it a name to the 
image in the File Name field, and click SAVE. (Remember that the file name must be up to 

250 CHARACTERS, special characters may not work, it’s recommended to use only alphanumeric 
characters). 
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6.- Finally check the contents on the microSD card. Safely remove the micro SD 
card, then insert it on the SMART GPU and call the image! 
 
 

 
 
 
 
7.- Follow always the same procedure to load images onto the microSD card! 
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4.2 Storing Songs/Audio files on the micro SD card 
 
 Any Song/Audio file could be stored and played by the Smart GPU 2 processor, 
the only requirement is the .wav extension and WAVE format.  
 
 From a music CD, just extract the files/songs in .wav format and place them into 
the microSD card to be played (see SmartGPU2-Audio Player-CD Tutorial.pdf). 
 
 For PC stored files with any other extension than .wav, use any Audio processing 
software to convert .mp3, .wma, .atrac, .mp4, etc. to .wav supported format. To keep it 
simple, in this section it’s explained how to convert any file to .wav using the popular 
apple’s iTunes software. 
 
 
1.- Open the iTunes software. 
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2.- Go to Edit->Preferences, and click. 
 

 
 
 
3.-A new Window pops up, then click on the “Import Settings…” box: 
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 3.1- A new window pops-up, now select “WAV Encoder” and change  
                  setting “Automatic” to “Custom”, then click OK: 

 

 
 
-Select the desired Sample Rate, 8/16 bit Sample Size and MONO or 
STEREO Audio and click OK. The best audio quality is achieved with the 

44.100Khz, 16bit, Stereo parameter). 
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3.2- Now select the “Advanced” tab to visualize the path where converted 
files/songs will be stored, finally click OK to close the window: 

 

 
 
4.- Once again in the main window, select the desired songs to be converted: 
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4.1- Once the desired songs are selected, perform right click on the mouse and a 
new menu will pop-up, click on “create WAV version”: 

 

 
 
 
5.- Wait for the files to be converted, then search for them in the iTunes Media 
Folder previously visualized with the Advanced Preferences Tab. User could copy all 

the files with the folders directly to the microSD card to be sorted by artist/album/year, etc. 
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6.- Finally, copy the files to microSD card and check the contents. Safely remove 
the micro SD card, then insert it on the SmartGPU 2 and play the files! 
 

 
 

 
7.- Steps 1-4 must be done only for the first time to setup WAV conversion, once 
iTunes is configured, user could repeat process from step 4. Follow always the 
same procedure to load song/audio files onto the microSD card! 
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4.3 Storing text files on the micro SD card 
 
 Any text could be prepared to be stored and loaded by the SmartGPU 2, the only 
requirement is the .txt extension and desired size.  
 
 Any text processing software could convert or “Save As” text as .txt. To keep it 
simple, in this section the universal and easiest to use: Microsoft Notepad software is 
used. 
 
 
1.- Open the Note Pad software. 
 

 
 
 
 
2.- Go to File->Open, and select the desired text file, or write your own text. 
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3.- Go to File->Save As, and click on. 
 

 
 
 
 
4.- A new window pop-up, select any path of the microSD card, give it a name to 
the text file, be sure that the “.txt” extension is selected and click SAVE. 
(Remember that the file name must be up to 250 CHARACTERS, special characters may not work, 
it’s recommended to use only alphanumeric characters). 
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5.- Finally check the contents in the microSD card. Safely remove the micro SD 
card, then insert it on the SMART GPU 2 and call the text file! 
 
 

 
 
 
 
6.- Follow always the same procedure to load text files onto the microSD card! 
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4.4 Formatting the micro SD card for first use 
 
  

It is recommended but not necessarily to format the micro SD card for first use, in 
this section a format to new micro SD card to FAT format is explained. 
 
 
 1.- Open a new  explorer window, right click on the microSD card and a menu 
appears, select “FORMAT…” and click. (Note that formatting a micro SD card will erase all 

the contents of it). 
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2.- A new window will pop-up, choose FAT(default) or FAT32 on the File System 
menu, and click start.  
 

 
 
 
3.- Click OK on the new window and wait to the PC to perform the format.  
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4.- Now the microSD card is ready to load images, songs and text! 
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5 Development software tools 
 

In order to make even easier the learning about how to communicate with the 
Smart GPU 2 processor, FREE software could be downloaded and used in any PC.   

  
This software simulates most of the functions of the Smart GPU 2 chip by 

connecting it to the PC through the USB-UART SX Bridge, this connection enables real 
live graphics processing. 
 
 This software greatly reduces the time of learning the commands, and helps the 
user to understand how commands are created as it shows the sent and received 
commands by the PC<->Smart GPU 2 processor. 
 
 

 
 
 

For detailed information about this software and how to use it, please refer 
to the “SMARTGPU2-PCsimulation.pdf” sheet that could be downloaded in the 
web site. 
 

For detailed information about the USB-UART SX Bridge, please visit our 
web site. 
 
 
 
 
 



SMART GPU 2 2.4” TOUCH Datasheet         

 

 
Vizic Technologies ©2013                                                                                                               39 

 

 
6 Mechanical dimensions  
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7 Specifications and ratings 
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CHIP processor: 
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VIZIC TECHNOLOGIES COPYRIGHT 2013. 
THE DATASHEETS AND SOFTWARE ARE PROVIDED "AS IS." VIZIC EXPRESSLY 
DISCLAIM ANY WARRANTY OF ANY KIND, WHETHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR 
NONINFRINGEMENT. 
IN NO EVENT SHALL VIZIC BE LIABLE FOR ANY INCIDENTAL, SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES, LOST PROFITS OR LOST DATA, 
HARM TO YOUR EQUIPMENT, COST OF PROCUREMENT OF SUBSTITUTE 
GOODS, TECHNOLOGY OR SERVICES, ANY CLAIMS BY THIRD PARTIES 
(INCLUDING BUT NOT LIMITED TO ANY DEFENCE THEREOF), ANY CLAIMS FOR 
INDEMNITY OR CONTRIBUTION, OR OTHER SIMILAR COSTS. 
 
 
 
 

Proprietary Information: 
 

The information contained in this document is the property of Vizic 
Technologies and may be the subject of patents pending or granted, and must 
not be copied or disclosed without prior written permission. 
 

Vizic Tech endeavors to ensure that the information in this document is 
correct and fairly stated but does not accept liability for any error or omission. 
The development tools of Vizic products and services are continuous and 
published information may not be up to date. It is important to check the current 
position with Vizic Technologies at the web site. 

 
All trademarks belong to their respective owners and are recognized and 

acknowledged. 

 
 

Disclaimer of Warranties & Limitation of Liability: 
 
Vizic Technologies makes no warranty, either expresses or implied with 

respect to any product, and specifically disclaims all other warranties, including, 
without limitation, warranties for merchantability, non-infringement and fitness 
for any particular purpose. 

Information contained in this publication regarding device applications and 
the like is provided only for your convenience and may be superseded by 
updates. It is your responsibility to ensure that your application meets with your 
specifications. 
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In no event shall Vizic be liable to the buyer or to any third party for any 

indirect, incidental, special, consequential, punitive or exemplary damages 
(including without limitation lost profits, lost savings, or loss of business 
opportunity) arising out of or relating to any product or service provided or to be 
provided by Vizic Tech, or the use or inability to use the same, even if Vizic has 
been advised of the possibility of such damages. 
 

Use of Vizic’ devices in life support and/or safety applications is entirely at 
the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless 
Vizic Technologies from any and all damages, claims, suits, or expenses 
resulting from such use. No licenses are conveyed, implicitly or otherwise, under 
any Vizic Technologies intellectual property rights. 
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